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Getting started (tutorial)

“This tutorial wil familiartze you with the user

Importing a mode

Amodel of e part needs 1 be imporiad foe ansiysis. The modal s saved nto a Study i & Project

Aprojct s used on et e and can e aniyzea
win et B Turveriocke)
Tutorial duration: Approximately 50 minutes. confiquratons, matertal fora o the
sty 2 e sy 0y
o material, moid design, and processing peciidy s "
concstons that il produce quaty fiished parts :
o project or
The ok eako Dot you s perioer arei You wit now create a new project and import a study iro it
1. Importing a model Creating n new Project
2 Creatrga e ats0 known as )
o ¢ g 1 Cack ) (Stat & Learn 1 > Launch pansi > New Progect) The Croats New Project dakog appears
3, Repainng the mesn f 1 contans errors Tre etau e ocatn or & propct ot can e changed at
4 Nodeing he moid (caviy ayout feed system, and cooing) g e
5 Analyzng the study. E Vo, cick Browsa and
6. Vhewnng and eterretng he resuls of the anatyses e 1o required oker
7. Adusting the mokding parametors based on the analysis results 2 Bt uarved 1) e PO Pkt e DR
o tra v Comste ctwi o scro :
Profctnama yo have adare ke s GoSCrGan A bfoderCaled Gafing S has boen
3 Cack 0K

Anew Getting Started project is created and cpened
Cack 4 (Home tab.

> Import panel > Import)

Select the Files of type drop-down It The fist of fle types directly supported is shown Select Study files
(tady)

& Navigate to the Tutorfal foider. typically C\Users\Public\Public DocumentsiAutodesk\Moldiow Synergy
20wxutorial)

7. Cack on the file tutorial_model sy and click Open
T 1 i3 imported, and a new study is automatically created in the *Getting Started” project. This is
Ilustrated In the Project View pane

8 Cick Q

 (View tab > Navigate panet > Zoom), Click anywhere in the model dispiay pane and drag the cursor
verticaly up of down tha scroen 10 fesize the model

The imported study shoukd appeat as follows:

Note: You €1 import a model fom outside this product and store # witin a project 35 a study, Once i stored
Within a project, you Open the study from witin the proj

Cck the Next topic link below to move on to the next task of the tutorial

Model manipulation

I s task, wil look a the tools inat are available fo rotate and zoom in and out of sections of he model you
opened i he previous task

Ensurs the model from the previous task s open

1, Gk (View tab > Navwgate panet > O
2 on e madel and, with hekd down, mave the mouse. Tha modal wil pivot
Tis is usetul geomatry of the part.

3 Using the
ongnal orien

ViewCute, click Front view 10 feturn the mode 1o 85
o
Other views of the model can be quickly obtaned by cieking on the five other scdes of he ViewCube,

Thés view can be acjusted by clicking & (View ta > Navigate paned > Pan) Giick and drag on the model untl
postion

5 Cuck R (View tab > > Zoom Window). solect the ares
‘around the fop left hole in the mods. The area you pane

selected is now expanded io fa the Model
:l

ik 3 (View 196 > Navigate panec > Zoam) Gk and g down i he Model Dispy panel, striking the
imaga i the whale ot madei = isti

Th model is now showing n the loe ight hand section o the panel

-
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8. You can select ihe pivol point by cick w tath > Navigate panel > Canter). Click 6n the upper fight of
the model and rolale the part again fn e section, you w e he diferent sectons o the raphical user nte
This feature is used 1o help investigate local condion: : P—
9 To retum the model 10 f1s onginal condition, select Front View using the ViewCube and then @ (View tab >
Navigato panet > Zoom Al "
Model pane User interface-project panel
The Model pane s he kargeat secton of e user nietacs
Tho Project panel dpiays information abut he oo 1t bag anayzsd
§ s e previos 136K 3 0pon, ANiemavely, open tutorial_model from he Gatting Started
3 1 he Importing a model ticns

1523610 the frone
a1 a det. A 3 Menws > Options > I
y kaunch the D F sion G a web page designed for hare your > User Intertace) and
=sed o fhe Aut be se the Discussion

The Tasks tab

C———

00 you are displaying shows (at the cuTent proyect is Getting Started and the only study currenty

ible 5 tutorial_model (Ihe study you ofiginatly imported)

There are two sections to

1 Project View pane
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2 Study Tasks pane
The Study Tasks pane is the lower sacti
are displayed. Th

of the Tasks tab and this is where datails about your actve study
e status of the tasks fequired before analys:s and tha

nerated afe S0 shown

Tho Tools tab

The Tools tab is the secont

wally tequre some

i the Tools tab.

1. From the Results section
requied 1o ff the mokd

s

R:
LE

e e o rrvest

ment wih e oth

of th Study

ot the Pro

marspulation of geometry or de

asks pane. tck Fill Time for @ visia

tigate ths resust

analysis fesults that are avalable

o0 of features pnor 1o analysis. The modesng

4 Ciick % (Mesh tab > Mesh Diagnostics > Aspect Ratio). The Aspect Ratio Diagnostic dialog opens in the Tools
b This feature i explained in the meshing tutora

neter s the defauil of &

6 Tick the Place results in diagnos

7. Click Show

8 The lines that appes
The cofor of the fine i

s layer option.

i the Modet pane indicate the Jocaion of elements with an aspect falio greater than 6
cates the magnitude of the issue.

9. Rotate and zoom into sections of the model to investigate the elemes
these resuts in the Layer panel ta

s with a high aspect ratio, will revesit

10 Rigt

f-chck 0

the model and select A Mesh Diagrosics o remave e nes

1. Refurn the madel 1o s onginal oien

on 25 outined in the Modk

manipulation task Using the

ViewCube. sedect Front and then cick & (View

panel > Zoom Al)

User interface-layers panel

Layers aro ational &
manputating. and e

Each layer can

playod ot

ne Layers Pane i located in the boftorm

date components of yous model. Th

3 your model moxe effcsenty

354, octivate, Golete. ar
mee wncividuall of wi

v layers.

4 the graghics user intertace

Sp——

oty T layers associated wah your active moded

panel s not showing,
down menu

C(View tab > Windows panel > Uset Intertace) and select Layers from fhe drop-

Ensure the working model rom the previous task is o
the Tutorial folder found typically at C UsersiPy
200dntortal

en, f this model
s Publy
uforial, chck tutorial_model and ciick Open

ot open, click File > Import. Navigate to
DocumentsiAutodesiiMoldfiow Synorgy

Although they are not displayed, there are two cooling channels an
these features, along with the visible
presented by

an injection point defined in the model. Eac
ianghes and nodes (to be explained in the Meshing tutorial). are
the Layers Panel

g different check boxes in the L

yers Panel and observing the effect in the Mode! pane
You may want o fotate the mode! to view the two cooling channels

2 Tick Triangles i the Layers pane 1 retum the model to

s oniginal form

User interface-logs pane

‘At 30 analyss has been run, the
Logs Pane
The fesuts of n analyss can be

‘.
)

o Fill tieme a0 hgh Aspect Ratios . The rumarical vahues of i avalatie tesulls are aeo o
rorview 18 presenied  The Logs pane.

Logs pane is osp

o e Mol pane.

resentid i several ways. You

v arescy ved v

sl eprsertane
—g
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The Logs pane can be hidden of displayed at any time by licking e Logs box in the Study Tasks pane.

Ensure the model from the previous task Is open. Altamativey, select tutorial_model fiom Ihe Getting Started
ect

1. Seloct the Tasks tab from the fop of the Project pane
2 Seloct i Logs bax In the Study Tasks pane.

3 Select te Analysis Log tab from the top of the Logspane:
4 Soroll up and down the screen 10 view the output resuts.

Finally. you can g "t speciic combinations of Ths wil bo
adaressed i the Post.Processing titorial

Meshing (tutorial)
T ot wil 1eachy0u how K bsectanc Qenerate e apFOpAE e ype, and ik you aware of
e Wit mesh hat may arse

Tutorial duration Appronmatesy 55 mises

Analyzing  modet s 3 complex operation Modeling The way moen pIASUE (3 hon-Newtorsan fsd) fows
espocilly trough compinx modl grometry. s Affcull

To overcome these fssues, a part is diided nlo smaler elements it are joined fogatnes. Tr
Temperature. pressure. and veloory of fow foc gac

resutt s 3 mesh
g 3
oftect i3 a reprosentaton of the whole frodel

Theoe diferent types of mesh (analyses ochacioges) s av

e
-
+ Dual Doman
-3

Each of Mese wi be discussed in this tutorial along with
« How 1o salect and generata the approgwiate mesh type
+ Problems with a mesh

Midplane mesh

Mistoncally a part wies heshier by deferirining the uckness of 1o part and then assigring a surface pane
hrough he middia of he thickness.

This surtace was then feshed with triangular 5 and o

Pces) The tscaness of fhe a1 screed m each efement The analysis than incorporafes thi meassiremant by
g th the part into tn This

calcutations can be perormed

1f you want 10 use a Midplane analysis, ensure e CAD package you Use can directly generate  Midplane model
c 3 oo very tme

In this task, you wil

» Import a Mdpiane model
« Investigate how the mesh is structured

1. Cick ) (Start & Lean tab > Launch panel > New Project)
Enter Mes) 1
Cack OK

for 1ne Project Name

Cick £] (Home tab > import panel > impon)
Select the Files of type drop-down list The st of fle types directly supported is shown, Select Study files
(sdy)

Navigate to the Tutorial foider, typically C\UsersiPubliciPublic Documents\Autodesk Moldfiow Synergy
2000utorial

Select dustpan_midplane sdy then click Open

Rotate and zoom -
tepresented as a Midplane model
9. Note that e Midplane Mesh type and numiber of elements i the model are displayed in the Study Tasks

o way the mode f

Dual Domain mesh

A Dust Domain mesh ropresents a solid CAD modal by Covering the surface of the model wih rianguiar elements
The cormers of the tranguar elements ae caed nodes

The o could be visuaized 83 & hofow body covorod with 8 surtace shet

WWhen anayzing a part. he volueme of e mode 5 represented by layers Iough e ckness of e part
{typicaty 10.0r iho Mickness) ©3 cies o the port must be matching
50t tayers can be but These TL ticknes:
Thess layrs enatie an accurata fepresentation of i, Coss-soctoned parts, whie fhere s 3 fagidly changng
characterite profie, for examjie, temperatire and fow-ont veloody

I this task. you wil

« Import a Dual Doman model
« Investigate how the mesh is stnuctured

Ensure the Mosh tutorial project you used in he previous task s active. 1§ i, cick @ (Start & Loar
> Launch panel > Gpan Project) and sodect Mesh utoral

ik 41 (Home tad > Import pane > tmport)

From the Files of type drog-down s, select Study files (*:ady)

Navigate 1o the Tutoril foder.typically C: ymerg
2omciutonial

Select dustpan_dual_doman sdy then click Open

Clck b View tab > Navigate panel > Selact)

Gk 00 a0 element (Irangie)in the model and priss Desete on your keyboard

Clck -+ Canter and cick on an element adjacent 1o the deleted element This wil centraly

investgation

9. Rotate and 200m in on fhe mode! o understand he way the modei has been regresentod
 the Dual Domain Mesh type and nurmber of lements i the model are displaye in the Study Tasks

e area under
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3D mesh

A 3D mesh regesents the CAD model by fling ihe yolume of ha model wih four-node, tetrahedral elements
(tetras)

3D meshes work welfor parts that ace thick or sold because fetras give a tnue 30 fepresentation of the model A
30 - e for Mdplane or Dual Dom: Theretore, 30

This makes a e for
hick modets with compiicated shapes, while Midptane and Dual Dormain meshes are more applicable for thin-
walled, shell-tkn parts.

I this task. you wil
« Import @ 30 model
« Investigate how the mesh is siructured

1

¥ in the active. Aematively cick @ (Start & Leam
tab > Launch pane! > Open Project) and select Mesh tutorial

2. Click 1 {Home ta > Import panel > Impor).

3. From the Files of type Grop-own hst, select Study files (*ady)

4 Navigate is installed, typicaly C:
Documents\AutodeskiMoidfiow Synergy 20niutorial

5. Select dustpan_3d sdy then click Open
6 Cilck b (View tab > Navigate panelSalac)

7.0 ement (tstra) in the mode! your keyboard
& Rotate and zcom in on the moded 5 investigate the way the model has been represented

) ah type ‘lements in the model yed in the Study Tasks pane
10 When you thvee model the last tasks, close the studies.

Meshing a mode! <
Y accuracy of your resuts
bt

from  CAD peogram
It task. you wil

 Imperta CAD model

+ Generate a mesh on the moded

+ Commparo o oftect o oot mosh censes.

: sy et , The rassans

ot are:
« Most part geometry 3 shes-tae n appearinoe, which s utable for Dust Domain anatyss.
. Do

v the mesn s

+ A30 mesh requires a good Dual Dorma mest of the model as s startng port. This Dual Dorrar mesh i
30 mesy o y 230 mes

5 2 Dust Dcrrien mash

1 Ensuro the Mosh tutorial peoject you used n the previous task s active. I 13 not already open, click @ (
‘Start & Learn tab > Launch panel > Open Project) and solect Mesh htonial

Home tab > Impart panel > Importy

3 In the Files of type arop down ks, select IGES(".igs.iges).

4 Navagate to Tutoral folde. typically ey
20mcitutorial

5 Sefect Dusipan IGS and cick Open

6 In the Import ialog, ensure Dual Domain is the mesh type selected
Mote: If you have Autodesk Moldflow Design Link installed, you can check Ihe Process using Aulodesk
‘Molaflow Design Link ption 1 Impxowe the quaity of he imported mesh

7. Click OK
Late i his task. you are going to compare s
that you can compare resus

& Seloct Dustpan,_study i the Stuy Tasks pane.

9. Right-cick on Dustpan_study and select Duplcata from the drop-down men

Right-ciick on Dustpan_study (copy) . 3nd sefect Rename fom the drop-dow mens

11, Enter the new study name Dstpan, sk and dick Enter

You wil now generate a Dual Domain mesh for his part. Doutie-chck Dustpan_study in the Study Tasks

pane.

8

13, I the Study Tasks pane. double-click > Creats Mesh
The Genetate Mesh pane of the Tool tab appears

14 Ensurs the General tat i selected

15 Note the suggested Global edge length on surface of about 112 mm.

16, Click Preview, he majoe nodes that you wil ger shown.

17. Change the Global edge length on surface 10 5 mm

18 Cl mest your change

19. Click Mesh Now, The Mesh Cick the dialog and begn
the meshing The generaton of the mesh wi take a short time. The Mesh Complete message dalog
appears. Cick OK lo dismiss the dialog

20, Rotate and 200 in on the part pecally edge:

211 e Stucy Tasks pane, note that the now identifes Mash

Note tha rurmer of elemants in the mest
Athough 5 iner mash gives a better result, there s a point beyond which additional mesh densey fais to.
time.

sl y
22 Doutle<iick Dustpan_mesh in the Study Tasks pane.
23, In the Study task pane, double-cick Create Mesh

24 Ensuro the General tab is selected.

25 Lean dge length on surface 1.2 mm),
26 Click Mesh Now. Ci that betore and
2 bosn created,

28, n the Study Tasks pane. note the number of elements in the mesh. This mesh has fewer elements than the
model

fat s possidle |

This length y A

i 10 one-half of the inital vakue. Aemativly, a Giobal adge length on suface should be about 2 tmes the
for a 3D mesh, and 2

You Wil now altar the mesh densdy.
29 Maka sute tho Dustpan_mesh sudy is the active study
30. I the Study Tasks pane, right-ctick “ Dual Domain Mesh
31. Seiect Generato Mesh
2 . 1ab, ater the G & 5mm
3. Chock ibe Romesh already of tha s located
34 Inthe Layers panel. I IGES Surface and IGES Curves ave sted. ensuro thay are not ticked
35 Click Mest Now. Close the " betoce and af

36 The mesh densty of the modet has been atisred. in the Study Tasks pane. note the pdated number of
elements in the mesh
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Checking the mesh for errors

When importing of meshing a part This is
the cause of many erors, especially In areas of e detad. The Inclusion of surface lexture, smal (o, of flkets,
roduct leads ploxity

CHAractenSCs o1 e MesN. Ve Will KOK 51 83Ch Of These Sections

y section, #is impon 0 bons vale.

fogion. Any more than this wh indicato disconnected sections of the part o funner system|

« In the Edge Detals section. tne infegeiy of the surface edges are determined.
Froe eses are not surtace

Dual Domain and 3D meshes.

iached 1o i This

for 0 Dual Domain mesh
aftached 10 . For & Dual Domain mesh, his vake showd

bezer,
« In the Onientation Details meshi
eror but o Ths

colane Ousl Dorman
Mcpiana Ousl Doman.concracal v 201
Torn wirents o1
st Do mash bakors onverson 10 30 B
oot end Warp analysse 1

Very high aspact raio iangfes should be avoided. especkaly whon the longest side s n the ditection of fow
ropert

o, You wil imvessgate t1s tater
. e mesn maten
Thi

lements on the opposi T ¥ for par
fiber orlentation prediction.

n this task. you wit

« Creato a Mesh Statistics the quaity of n the tast task
« Run the Mesh Repair Wizard to check for and repair a number of common mesh defects

1. Open the Mesh tutorial project you created n the previous task. Click @ (Start & Learn tab > Launch panel >
Open Project) and navigate to the project diractory where your projects are stored.

2. From the Mesh_lutorial folder. select Mosh tutorial.mpi

3. Click Open

4. Click £) (Home tab > Import paned » import). From the Tutonal fokder, typically found at C\Users PutiiciPublic
DocumentsAutodesk\Moidfiow Synergy 20xctutonal, select mesh_tulonals sdy,

. Ciick B (Mesh tab > Mesh Diagnostics panel > Mesh Statistcs).

6. Click Ciose when you have g the information i the Mests

7. You wif now run the Mesh Repair Wizard to check for futher mesh defects. and to ry 10 carrect the high
aspoct ratio elements automatically. Click T2 (Mesn tab > Mesh Repair panel > Mesh Regair Wizard) The
Mesh Repair Wizard opecs at the Stich Froe Edges page

edges that 000 This
s Bustrated on the lef of he dialog Ther are 0 free edges found™
On each page of the wizant
« Ita diagnostic indicates a probiem, cick Fix 1o try the probiem. Fix o
correct problems
» Click Sk 10,90 1 the next diagnostic withoxdt rying 0 fx the problem
ci $age of the wizard. By chcking Next, you can

. a
1ot 520 if the problem was resolved

80 page at there are o holes In the mode,
The not part

of the model surdace. Thes is a Dual Domain related issue only.
10 proceed 10 each
100150 have a high aspect

ather nodes. (¥c
ratio). Fo this model. no degenerate elements were found.

11, Cick Neat to proceed 10 the Fip Normal page. The fesul indicates that il slements in the model are orented
consistenty
o Next 10 proceed 10 the Fix Overtap page. The fesul indicates thal there are 0o intersectons of
overlapped surtaces in the model
Cick Next 10 proceed 10 he Cotapsed Faces page. Wher boundares on opposte surtices unexpectedly
touch. you have a collapsed surface. F of view.a colapsed an cbstacie
10 1 fow and 50 wll Mpact on fesults n the kooa area, The resull ncicates that thefe s 10 cotapse o6 the
model boundary.
G et o proceed 10 the Aspect Ratio page. As n ihe Mesh Statistcs roport, the minimur, maximum, and
average aspect fabo values aro foportod
15 Seloct to dispiay plot
high aspoct y
dispiay pane, The Aspoct o
fatio olements. The asy
e element. The longor 1he tpike, 1o highee tho aspect atio, The cokr of e gpike also indicates the
magnitude of e aspect rato. The calr Aght of the pane 153
16 Cick Fix on the Aspect Ratio page 1o run
di

pane. An

There aro st be

foxed automaticaly.

17 afer Repair Wizard
However, in pai
will leam how 10 correct mesh eftors manualy.

18, Glick Next 10 proceed 10 the Summary page.
what method.

In the next task you

19, Click Close 1o ext the wizard.
20, Save and ciose the study.
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